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OVERVIEW
The user interface of Vic-3D has many of the familiar control elements found in other applications. The image below illustrates 
the user interface. The most commonly used functions can be accessed by clicking on tool buttons on the Tool Bar. The windows, 
such as the AOI Editor and Plot windows are grouped inside a Workspace. The List View on the left of the main window provides 
a quick overview of image and data files.

FILE MENU

The FILE MENU provides the following functions:

       • New - creates a new project
       • Open - open an existing project
       • Open recent - select from recently accessed projects
       • Save - save the current project
       • Save As... - save the current project under a new file name
       • Mode - select a Vic-3D project type (3D, realtime, stereomicroscope, etc)
       • Install module licenses - use this menu entry to activate software modules you have purchased
       • Quit - quit Vic-3D



EDIT MENU

The Edit Menu provides the following functions:

       • Undo - undo the last editing operation in the reference image
       • Redo - redo the last editing operation in the reference image
       • AOI tools - each AOI tool is selectable from this menu.
 

PROJECT MENU

The Project Menu provides the following functions:

        • Speckle images- adds speckle images to the project for analysis
        • Calibration images - adds calibration images to the project.
        • Speckle image groups - add a group of speckle images with the same prefix
        • Calibration image groups - add a group of calibration images with the same prefix
        • Data files - adds pre-existing output data files to the project
        • Analog data - adds analog data files from Vic-Snap
        • Video clip - adds generated AVI files
        • Workspace - displays the 3D image correlation workspace
        • Marker editor - displays the marker tracking toolset
        • Show FFT workspace - works with frequency-domain data, bringing up the FFT calculation dialog if necessary. This 
           module may not always be present.

CALIBRATION MENU

The Calibration Menu provides the following functions:

        • Calibrate stereo system - calibrates the cameras and stereo rig simultaneously
        • From project file - import a calibration from an existing Z3D or V3D project file
        • Autocorrect calibration - corrects for a disturbed camera orientation calibration
        • Adjust for cropping - adjusts for differently sized calibration vs. speckle images
        • Calibrate camera 1 / 2 - calibrates camera parameters separately
        • Calibrate camera orientation - calibrates stereo transformation separately
        • Calibrate external camera - calibrate for overlay of auxiliary camera data (i.e., from an infrared camera)

DATA MENU

The Data Menu provides the following functions:

        • Start analysis  - shows the Run dialog to begin 3D analysis
        • Postprocessing tools - shows a submenu to choose from various postprocessing calculations
        • Coordinate tools - shows a submenu to allow coordinate system manipulation
        • Markers - allows exporting or fitting coordinates to marker data
        • Export - various options for exporting full data set or reductions

PLOT MENU

The Plot Menu provides the following functions:

        • New plot- adds a new plot window to the work space
        • 2D Plot- changes the currently selected plot to 2D overlay mode
        • 3D Plot- changes the currently selected plot to 3D plot mode
        • Inspector- allows choice of various data inspection tools



WINDOW MENU

The Window Menu provides the following functions:

        • Cascade - organizes all MDI windows in a cascade
        • Tile - tiles all MDI windows 

HELP MENU

The Help Menu provides the following functions:

        • User manual - show this manual.
        • About - show version information.

MAIN TOOLBAR

The buttons on the main toolbar control commonly used Vic-3D functions. From left to right:

File tools:

        • New project
        • Open project
        • Save project
        • Add speckle images
        • Add calibration images
        • Calibrate stereo system
        • Start analysis

Histogram control

Plotting tools:

        • Switch to 2D plot/3D plot
        • Workspace
        • Marker tools
        • FFT workspace (when module is present)
        • Zoom in/out
        • Undo/redo

Postprocessing tools:

        • Calculate strain
        • Calculate velocity
        • Time filter data
        • Calculate in-plane rotation
        • Calculate curvature
        • Apply a custom function
        • Remove variables
        • Retriangulate data
        • Remove rigid motion

The histogram control displays the gray level distribution for the currently displayed image. The red bars on the histogram may 
be used to adjust the image display. Double-click on the histogram to automatically adjust the balance, or drag the red bars to 
set the black and white levels manually. Double click again to remove the balance adjustment.



The balance control is for display only and does not affect image analysis or stored images.

ANIMATION TOOLBAR

The buttons on the animation toolbar allow stepping through and animating image files or plots. The controls, from left to right:

        • Play - begins automatically stepping through images/plots.
        • Stop - stops the animation.
        • Step Back / Step Forward - goes to previous or next image/plot.
        • Loop - toggles between looping from last image to first, and bouncing from forward to backward animation.
        • Frame rate - selects the speed of the animation..

OTHER FUNCTIONALITY

In the right corner of the status bar at the bottom of the main window, the cursor position and image grey value is displayed 
when the mouse is moved inside the reference image or a deformed image. For 2D plots, this area will show the 3D coordinates 
as well as the value of the current contour variable. On the left side of the status bar, a short description of tool buttons and 
menu items is displayed when the mouse moves over them.

In the list view on the left side of the main window, some functions can be activated by right-clicking. Details can be found in 
the appropriate sections of this menu.



THE START PAGE
The start page in Vic-3D gives convenient access to frequently-used tasks, recent projects, and project type selection

COMMON TASKS

This section duplicates common tasks from the menu bar. Click to open a project, add speckle or calibration images, or view 
this user manual.

RECENT F ILES

This section contains a list of the most recently accessed projects. Click on an icon open the project; mouse over an icon to see 
recent plots and images..



PROJECTS IN VIC-3D
In Vic-3D, all the files and information associated with a test are stored in a project.

Initially, projects are blank. Before completing a Vic-3D analysis, the project must contain:

        • One or more speckle images , including a reference image
        • A set of calibration images
        • A calibration
        • One or more areas of interest

Note: Adding speckle and calibration images to the project adds them by filename reference only; they are not copied or moved 
on the disk.

When you run a Vic-3D analysis, the output files are stored on a disk and added (by reference) to the project file. If the project 
file is not saved or if the data files are manually removed, they will remain on the disk.

In addition to the items above, you can also choose to add auxiliary data references to the project file:

        • Generated video clips
        • Analog data files from Vic-Snap

NOTES

        • In general, it’s good practice to save project files often to avoid losing changes.
        • Vic-3D 2009 uses a new .z3d project file format. Older .v3d files may be opened, but not saved.
        • Once a calibration is performed and saved in the project file, the calibration images may be discarded if desired. All the    
           data calculated in the calibration routine is stored numerically in the project file.

CREATING A NEW PROJECT FROM A TEMPLATE
Vic-3D 8 allows you to create a new project by bringing in elements of an existing project, in order to streamline repeated tests. 
To begin, select File... New From Template from the main menu, or press Ctrl-Shift-N.



You will see a list of recent projects with previews. Single-click to select a project or mouse over to see a more detailed preview.

Select the elements you wish to import, and click Ok. A blank project will be created and you can now add images; if an AOI was imported, 
it will be automatically pasted. Note that Vic-3D 8 allows moving an entire AOI to account for small position differences; click once to 
select the AOI, and then click and drag.

        • To calibrate an external camera, there must be a sequence of calibration target images for that camera; at least one of those images 
            must show the grid in the same position as one of the stereo calibration images. If the external camera cannot be synchronized, 
            then you may have to image the grid one time in a fixed position, in all three cameras; the remainder of the images do not need 
            to show the same poses.
        • The calibration grid used must show contrast in both the DIC calibration images, and the external calibration image. For the case 
            of an IR camera, this means using a grid that shows contrast in both the visible and IR spectrum.

Begin by clicking Calibrate... Calibrate External Camera from the main menu. A file selection dialog will appear.



 

Select the calibration files for the external camera and click Open. You will be prompted to select a camera ID.

Multiple external cameras can be calibrated; select an ID, or when using a single external camera, simply click OK. A single-camera 
calibration dialog will appear.



Calibrate proceeds as usual (for details, see the Calibration Dialog topic), except that you must select a grid orientation using the pulldown 
at the bottom right:



This must be the same grid orientation you selected during stereo calibration; if you did not select the correct orientation at 
that time, repeat the stereo calibration, selecting the same orientation.

Once the calibration is complete, click Accept. To proceed with mapping the external data, run the correlation, and then use 
the Map external data postprocessing tool.

THE PROJECT TOOLBAR
The plot toolbar is displayed at the left side of the work area by default. It contains information about image files, data, and 
calibration for the current project.

THE IMAGES TAB

This tab shows all speckle and calibration images associated with the project.

To add speckle images, select Images... Speckle images from the menu bar, or click the speckle images icon on the main toolbar. The 
small red arrow indicates the reference image; to set an image as the reference, right click and click Set as reference .

To add calibration images, select Images... Calibration images from the menu bar, or click the calibration images icon on the 
main toolbar.

To remove an image or series of images, select them, right click, and click Remove or Remove selected.



THE DATA TAB

The Data tab lists all output data, analog data, and video files associated with the project.

All generated output files are added to the Current data list. Output files not associated with current speckle images are added to 
Other data. Double-click on a data file to view a 3D plot.

Analog data from Vic-Snap is listed under Analog data. To add an analog data file, select File... Add Files... Add Data Files from 
the main menu. To view a spreadsheet of the data, double-click the filename.



Generated video files from 2D and 3D animations are added to the Video files list. Double-click on a video to display it in an 
external viewer.

THE CALIBRATION TAB



This tab is a static display of the current calibration information for the project.

Intrinsic parameters are displayed for each camera:

        • sensor center
        • focal length (in pixels)
        • skew
        • 1, 2, or 3 radial distortion coefficients, depending on selected order

Extrinsic parameters are displayed for the stereo rig:

        • Alpha (rotation about the optical axis)
        • Beta (stereo angle)
        • Gamma (tilt)
        • T x, Ty, Tz: relative translation of camera 1
        • Baseline: distance between cameras (resultant of Tx, Ty, Tz)

SPECKLE IMAGES
In Vic-3D, speckle images are image or set of images taken of a specimen as it undergoes load or motion. You may add one or 
multiple speckle images by selecting the Speckle images entry from the Project menu, or by clicking the           icon on the main tool 
bar .

If more than 300-400 images are to be added, select Project... Speckle image groups to add sets of images from a specified 
folder. Select a folder to see a checklist of image prefix groups; select one or more to add as speckle images. (Trying to add too 
many images directly through the normal Speckle images dialog may result in an error due to operating system limitations.)

After adding speckle images to the project, they will be displayed in the workspace and listed in the Images tab of the project 
bar as shown in the figure below.



VIEWING IMAGES

Deformed images can be displayed in the workspace by double-clicking on an entry in the image list view. Alternatively, clicking 
the right mouse button on an entry of the list view will show a popup menu providing different options, one of which is View.

When viewing deformed images, you can use the zoom in/zoom out entries in the Edit menu or the corresponding tool buttons to 
change the scale of the displayed image.

ANIMATING IMAGES

To animate speckle images, display an image and then use the controls on the Animation Toolbar to animate the sequence.

CHANGING BETWEEN CAMERAS

To change between the two cameras of the stereo-system, right-click on the image viewer. A popup menu will be displayed as shown 
in Figure 3 allowing to change between the images taken by the two cameras.



REMOVING IMAGES

Calibration images can be removed by selecting one or multiple images in the list view, and right-clicking on your selection. 
Select Remove or Remove selected to remove images from the list.

THE REFERENCE IMAGE
The term Reference Image is used in this manual to describe the image of the specimen taken while no load was applied. All 
displacement analyses in Vic-3D are with respect to this reference image, i.e., the displacements are obtained in a Lagrangian 
coordinate system.



To select a reference image, right-click on it in the Speckle images list, and select Set as reference.

After the reference image has been selected, it will be indicated with a red arrow in the images list.

When the reference image is displayed, the mask tool buttons become active.



SELECTING AN AREA-OF-INTEREST
Vic-3D supports the following types of AOIs:

        • Rectangle: Points are contained in a rectangular area.
        • Polygon: Points are contained in an arbitrary polygon.
        • Circle: Automatically creates a roughly circular polygon.

To specify a particular type of AOI, select the corresponding entry in the Edit menu or the appropriate button on the tool bar. The selected 
AOI type will be indicated by the mouse cursor. 

After selecting the AOI type, move the cursor to the desired position in the reference window and click the left mouse button. You can 
now move the mouse to the next position, e.g. the end of the line or the second corner of the rectangle. Clicking the left mouse button 
again will complete the AOI selection for all AOI types except polygons. For polygon selection, a double-click is used to specify the last 
point of the polygon.



EDITING AOIS

To edit an existing AOI, select the Pan/Select tool. Mouse over any of the white nodes in your AOI; the mouse cursor changes 
to indicate node movement. Click and drag to move. You can delete a node by clicking the  icon, then clicking the desired node.

If the merge polygons icon () is selected, any overlapping polygons will be merged with each other. If the icon is not selected, 
overlapping AOIs will remain separate.

CUTOUTS

For rectangular and polygon AOIs, the scissors tool can be used to cut areas from the AOI. This feature is most commonly used 
if the specimen has cracks, holes, or other areas where correlation is impossible.
To cut an area from an AOI, click the scissors button on the tool bar or select Edit... Cut region. The selection of the area to be 
cut works like selecting a polygon AOI, i.e., corner points of a polygon can be added by single-clicking the left mouse button, 
and the last point is specified by a double-click. Once the cut is complete, new nodes are added to your AOI; these may be 
moved like other nodes.

CHOOSING THE SUBSET AND THE STEP S IZE

The subset and step size can be selected after an area of interest is created. Both are adjusted using the spin boxes in the AOI 
Toolbar.

The subset size controls the area of the image that is used to track the displacement between images. The subset size has to be 
large enough to ensure that there is a sufficiently distinctive pattern contained in the area used for correlation. If you change 
the subset size, you will see the current size illustrated by a grid briefly displayed on the AOI. To have Vic-3D suggest a subset 
size, click the        icon:



Vic-3D will choose a subset size which is calculated to give an optimal match confidence of 0.01 pixel for a given assumed noise level. 
The default of 8 works well for most cameras. To accept the suggested size, click Ok; to return without making a change, click Cancel.

The step size controls the spacing of the points that are analyzed during correlation. If a step size of 1 is chosen, a correlation analysis is 
performed at every pixel inside the area-of-interest. A step size of 2 means that a correlation will be carried out at every other pixel in 
both the horizontal and vertical direction, etc. Note that analysis time varies inversely with the square of the step size; i.e., a step size 
of 1 takes 25 times longer to analyze than a step size of 5.

To cause subset and step size changes to apply to every AOI, check the Apply to all box. If this box is cleared, subsets and steps can vary 
between AOIs.

PLACING START POINTS

In some situations, start points may be need for the correlation. To place a start point, click the        icon. The Initial Guess Selection 
page has more information about selecting end editing start points.

To remove a start point, click the             icon, then click the start point.

HINTS

         • Use the scroll wheel to adjust the size of the image.
         • When using multiple AOIs for one image, click on an AOI with the pan/select tool to activate it.
         • During AOI selection, the image can be scrolled by moving the mouse outside the reference image window.    
           This will cause the image to autoscroll if the image does not fit on the display.
         • You can use the Undo/Redo buttons to undo AOI selection and other operations. The Undo/Redo buttons 
           in the Edit menu will indicate what changes can be undone/redone.

CALIBRATION IMAGES
Calibration images can be added by selecting the Calibration images entry from the Images menu, or by clicking the           icon on the 
main tool bar .

After adding calibration images to the project, they will be listed in the Images tab of the project bar, as illustrated below.



VIEWING IMAGES

Calibration images can be displayed in the workspace by double-clicking on an entry in the list view on the left. Alternatively, clicking 
the right mouse button on an entry of the list view will show a popup menu providing different options, one of which is View.

When viewing calibration images, you can use the zoom in/zoom out entries in the Edit menu or the corresponding tool buttons to 
change the scale of the displayed image.

CHANGING BETWEEN CAMERAS

To change between the two cameras of the stereo-system, right-click on the image viewer. A popup menu will be displayed as shown 
in Figure 3 allowing to change between the images taken by the two cameras.



    Figure 3:Right-button menu in image viewer.

REMOVING CALIBRATION IMAGES

Calibration images can be removed by selecting one or multiple images in the list view, and right-clicking on your selection. Select 
Remove or Remove selected to remove images from the list.

CALIBRATION

Calibration can be accomplished either through a stereo calibration - where intrinsic and extrinsic parameters are calculated together  
or a separate calibration.

STEREO CALIBRATION

For most applications, stereo calibration is used. The calibration target is imaged simultaneously in both cameras, and the synchronized 
target images are used to fully calibrate the system in one step.



SEPARATION CALIBRATION

In certain applications, a stereo calibration is not practical. In this case a separate calibration method can be used.

In this method, each camera acquires target images separately. These images are used to calculate intrinsic parameters for the cameras. 
A static speckle image is then used to establish the camera orientation. For this method, the speckle image must contain markers or 
fiducial points with a known distance between them.

Cases where separate calibration will be useful include:

        • Very large fields of view
        • Cameras that cannot be synchronized
        • Cameras that must be moved after calibration
        • Certain complex mirror setups

STEREO CALIBRATION
To begin, select the Calibrate stereo system entry from the Calibration menu, or click on the              icon on the tool bar. The calibration 
dialog will appear:



For new, coded grids, the grid parameters will be determined and the grid points will be automatically extracted. If the grid cannot be 
recognized or is uncoded, select the grid from the Grid pulldown and click Analyze to extract points.

A number is displayed for each image - this is the total number of points extracted (0 for failed images). The computed dot positions 
are displayed during the extraction; the three hollow orientation dots are labeled with different colors, and the coding dots, if 
present, are labeled in red. 

Once image analysis is complete, the calibration will be computed. If the score is higher than optimal, any outlying images will 
be discarded and the calibration computed again. The final; score (in pixels; lower is better) is displayed in the bottom right.



Click Accept to use this calibration.

To use a certain grid orientation as the XY plane for the results coordinate system, select the relevant image from the Coordinate 
system pulldown. Use the Auto selection for a coordinate system centered about the camera rig.

When any of settings are  changed after completing calibration, if the Automatically recalibrate box is checked, a new calibration will 
be computed with the new option applied. To make multiple changes without recalibrating, clear this box and click Recalibrate 
as necessary. If you are using complex imaging systems (see below), the recalibration might be time consuming and so you may 
wish to clear the Automatically recalibrate box.

RESULTS IN DETAIL

For each image, a score is displayed. This is the average error (in pixels) between the position where a target point was found 
in the image, and the theoretical position where the mathematical calibration model places the point. Good scores will be displayed 
in green; higher scores will be red. To remove a certain image from the calibration, you can right-click on it and select Remove 
Points. To use points from an image which has been cleared, right-click again and select Extract.

Calculated calibration values are displayed in the tree view to the lower right. Each item has a value as well as a +/- confidence 
interval (one standard deviation).

To view a report containing all the information as text, click Report. This report can also be copied to the clipboard and saved 
for later reference.



RECALIBRATING

Vic-3D will attempt to remove any outliers while leaving good images present. However, it will sometimes be necessary to manually 
remove images, or return automatically removed images.

To remove an image pair, right-click in the results table and click Remove row. You may also select multiple rows at one time. 
If the Automatically recalibrate box is checked, the calibration will be immediately recomputed. Otherwise, click Recalibrate 
when necessary.

To return a removed image pair to the calculation, right-click in the table and click Extract row, or select multiple rows and right 
click.

To use a certain grid orientation as the XY plane for the results coordinate system, select the relevant image from the Coordinate 
system pulldown. Use the Auto selection for a coordinate system centered about the camera rig.

GRID SELECTION

If the grid used is not listed in the pulldown, click + to add a new one or Edit to edit the current settings. When clicking +, Vic-3D will 
attempt to automatically extract the grid information, and will fill it in if found; in this case, only the grid spacing must be entered.

To remove a previously entered grid, select it and click the - icon.

The diagram below illustrates the meaning of each grid parameter:



IMAGING SYSTEMS

To specify the imaging system used, use the Imaging System pulldown at the bottom left.

The imaging system comprises the sensor, the imaging lens, and any fluids or interfaces present (windows, environmental chambers, 
etc.) To add or edit an imaging system, click Edit; the following dialog appears.

You can add or remove a system by clicking the + or - buttons. The following parameters may be set for each system:

        • Name: this is a friendly name for the system; for example, “Schneider 17mm” or “Underwater test”.
        • Standard systems: select this for a typical imaging lens in free air.
                  Fixed aspect ratio: check to enforce a fixed aspect ratio when it is known for the camera.
                 Allow skew: if the camera is known to have zero skew, you can clear this box.
                 High magnification: check to force the Center parameters to the geometric center of the lens. This replaces the “High 
      magnification” checkbox in the previous calibration dialog.
                   Radial distortion: this is the order of the radial component of the Seidel distortion. Choose the appropriate order for your lens.
                 Prismatic distortion: this is the order of the thin prism component of the Seidel distortion.
                 Tangential distortion: this is the order of the tangential, or decentering, component of the Seidel distortion.
        • Complex distortion: select this when interfaces are present. This introduces a Variable Ray Origin calculation which allows
           correction for varying refraction across the sensor surface.
                 Type: select the appriopriate type for your application.
        • Click Finished when done.

To make an imaging system the default, click Set default. 



SEPARATE CALIBRATION
In some cases, it may be necessary or advantageous to calibrate the cameras separately - for their intrinsic parameters - followed by 
calibrating the system’s extrinsic parameters. With this method, the cameras are calibrated using a target, and the geometry of the two 
cameras is determined from a speckle pattern - either a speckle target, or the specimen itself. This method requires that two marker 
points with a known distance on the specimen surface are present in the images.

To calibrate the camera parameters separately, begin by adding calibration images to the project. Note: Vic-3D expects image files for 
both cameras to be present on the disk, even if only one of the two images is used.

Select Calibrate... Calibrate Camera 1 from the main menu bar. Proceed through the Calibration Dialog as with stereo calibration; 
repeat for camera 2.

At this point, each camera is calibrated but the stereo rig transformation is still undetermined; this can be confirmed by viewing the 
Calibration tab of the project toolbar, as below.

To calibrate the camera orientation, add a reference image to the project and select an area of interest (AOI). Ideally, the AOI should 
cover as large an area of the image as possible.

Since the system is not calibrated, you must provide an initial guess before beginning the calibration. Then, run the calibration. You will 
be prompted to run a disparity analysis:



Click Yes to continue or No to cancel. Continuing will run a disparity analysis, where the raw image disparities are calculated 
but triangulation is not attempted, and no 3D shape will be calculated.

Next, select Calibrate camera orientation from the Calibration menu. The dialog shown below will appear.



On the displayed image, click and drag select a line between two marker points that are a known distance apart. After selecting the 
line, the following dialog will appear:

Enter the distance between the two marker points and click Ok. You can click Calculate to finish the calibration, or change the selected 
line. On completion, a calibration score will be displayed:

High numbers indicate problems with the underlying data; if necessary, adjust AOI or initial guess and re-run.

FIXED BASELINE CALIBRATION

The Fixed Baseline option can be used when a stereo calibration is present but has been altered; for example, in a stereo rig where the 
cameras have been bumped, or disturbed by a very dynamic test. It can also be used in the general case when a correlation results in 
a higher than expected projection error.

The algorithm works by assuming that the stereo baseline is fixed and that only camera rotation changed. This assumption works well 
for most systems where the cameras are fixed in space by tripods or bars, but allowed to rotate on their mounts.

To perform this operation, select Calibrate... Calibrate camera orientation. Select the Fixed Baseline scale option, and click the Calculate 
button. A calibration score will be displayed; to proceed, click Accept.



CALIBRATING AN EXTERNAL CAMERA
In addition to the camera calibration for DIC, Vic-3D can also calibrate an external imaging camera to the DIC coordinate system. This 
is useful for mapping data from, i.e., an infrared camera.

        • To calibrate an external camera, there must be a sequence of calibration target images for that camera; at least one of those 
           images must show the grid in the same position as one of the stereo calibration images. If the external camera cannot be
             synchronized, then you may have to image the grid one time in a fixed position, in all three cameras; the remainder of the images   
           do not need to show the same poses.
        • The calibration grid used must show contrast in both the DIC calibration images, and the external calibration image. For the case 
          of an IR camera, this means using a grid that shows contrast in both the visible and IR spectrum.

Begin by clicking Calibrate... Calibrate External Camera from the main menu. A file selection dialog will appear.

Select the calibration files for the external camera and click Open. You will be prompted to select a camera ID.



Multiple external cameras can be calibrated; select an ID, or when using a single external camera, simply click OK. A single-camera 
calibration dialog will appear.

Calibrate proceeds as usual (for details, see the Calibration Dialog topic), except that you must select a grid orientation using the pulldown at 
the bottom right:



This must be the same grid orientation you selected during stereo calibration; if you did not select the correct orientation at that time, 
repeat the stereo calibration, selecting the same orientation.

Once the calibration is complete, click Accept. To proceed with mapping the external data, run the correlation, and then use the Map 
external data postprocessing tool.

ADJUSTMENTS FOR CROPPING
For many applications, particularly in high-speed imaging, the images collected during the test may not have been acquired at full 
sensor resolution in order to increase the frame rate or to save disk space. This can pose serious difficulties for normal calibration 
procedures. For instance, if a dog-bone sample is used, it can be advantageous to reduce the size of the image in the short dimension 
of the sample. This can lead to images that are only a few tens of pixels in one dimension, and it is practically impossible to image a 
calibration target in this case.

For such applications, it is best to calibrate the camera at the full resolution of the sensor and only crop the images during the test. The 
crop dialog seen in the figure below permits adjustment of the calibration in such cases.

The dialog permits the user to enter the top-left corner of the image section with respect to the calibration images for both cameras.

        • If a reference image is loaded during calibration with a different size than the calibration images, the adjustment dialog is 
           automatically shown.
        • The default values for the offsets are computed so that they are correct for most modern high-speed cameras that crop from 
           the center of the sensor.
        • For images taken with Vic-Snap, the correct values will be read from the TIFF metadata.



IMPORTING A CALIBRATION
To import the calibration from an existing Z3D or V3D project file, select Calibration... From project file from the main menu bar. You 
will be prompted to select a project file; when complete, the calibration will be imported and added to your current project.

INITIAL GUESS SELECTION
In Vic-3D, initial guesses will be needed very rarely. Some instances where they may still be necessary include:

        • Multiple, large camera angles (rather than a single stereo angle)
        • Highly curved surfaces such as cylinders
        • Large rotations between successive images
        • Very fine or indistinct speckle patterns
        • Poor calibration.

In the absence of these conditions, you can generally run the correlation immediately after selecting an AOI. If the correlation fails or 
runs very slowly, an initial guess may be needed.

CHANGES FROM OLDER VERSIONS

Vic-3D uses a new model for start points which is a bit different than the seed point used in previous versions.

        • Not every AOI will have a start point. In many cases you can just draw the AOI and run immediately.
        • You can now draw multiple start points. They will be analyzed in parallel and analysis will proceed outwards from each one at
           the same time.
         • Start points are no longer associated with a specific AOI; they can be placed in overlapping AOIs, or completely off the AOI. Start
           points which are too far from an AOI will not be used for anything.

PLACING START POINTS

Generally, it is best to place a start point in the area of the image that undergoes the least amount of motion during the test. For 
instance, if a specimen is tested in a tensile frame, the start point should be placed as close to the stationary grip as possible. Placing 
the seed point this way will help ensure fully automatic correlation.

If a specimen is expected to fail or crack, it may help to put start points on either side of the specimen so that once failure occurs there 
will still be a start point on both surfaces.

For very large transformations or rotations, it can be very helpful to place fiducial marks on the surface. This can be integrated into a 
printed pattern or simply drawn on the surface with a marker. These marks may be located much more easily than the random pattern 
especially if, i.e., one image is rotated 180 degrees from the other.

To place the start point, click the          icon in the Mask tools box from the AOI Editor. Once a start point is placed, Vic-3D will start looking 
for initial guesses in the background. If initial guesses are not automatically found, manual editing may be required.

EDITING INITIAL GUESSES

The initial guess dialog can be accessed by double clicking on the            icon in the AOI editor, or right-clicking and selecting Edit guesses. 
The Initial Guess Editor will appear.



The four windows on the left show the camera 0 and camera 1 reference above, and the camera 0 and camera 1 deformed images below. 
The small windows at the upper right show the zoomed-in guess for the same four images. The list at the lower left shows all 
the deformed images; where a guess is already present, the marker will be green. A yellow marker indicates a guess for only 
one image of that pair, and a red marker means no guess.

To add a guess, drag the corresponding square from the stereo or deformed image until it is in the same spot as the reference 
camera 0 image (at top left). To make control easier, you can zoom in and out of the image with the mouse wheel, or by clicking 
the          icon and drawing a box; or click the         icon to zoom into the current guess area. A histogram control is provided for 
the reference and deformed images. Adjust the red bars to control image balance; this can be useful for finding detail in very 
dark images. Double click the histogram to automatically set/reset the limits.

Below, the camera 0 deformed image guess has been dragged to the approximate correct location:



To check the guess, click the         icon, or just right-click in the desired image:

If the correct match is found, you will be prompted to right-click again to accept it. If the match is not found, you can check the location 
and try again; but where severe scaling or shear is present, you may need to add more details by adding more points or setting scaling/
shear with the control nodes.

DETAILED INITIAL GUESSES

To add deformation to your guess, you can add control points to the reference image by clicking the           icon. Up to three points can 
be added:



To specify the deformation, you can drag the corresponding points in the deformed image to matching points. Note that Vic-3D 
will not allow points that are too close together, or too close to colinear. Delete points by clicking           then clicking the point 
to remove.

While you are dragging, you will see that the small view to the upper right changes to reflect the transformed subset. When the 
match is good, the two views will look very similar:



You may also drag the control points on the red rectangle to adjust the transform more directly. The upper left control point 
affects rotation; the left and bottom points control X and Y scaling; and the upper right and lower right points control shearing.

In most cases where a manual initial guess is required, you will only have to provide a stereo guess (for the initial reference 
pair); the deformation guesses will be automatically determined during the correlation process. To help this work as smoothly 
as possible, take many images, and keep image-to-image displacements small; also, place start points in lower-motion areas as 
described above.

RUNNING THE CORRELATION
To run the displacement analysis, select the Run Correlation entry from the Data menu, or press the           button on the tool bar.

THE FILE TAB
The tab on the dialog displays the following options:

SELECTING IMAGES

The deformed images to use for correlation analysis can be selected from the list box on the dialog. Selected images are indicated by 
a check mark. Above the list box, buttons are available to select/deselect all image files contained in the list box. To select 1 data file 
from from every 2, 5, 10, or n , right-click in the file list and choose the desired option.

If no images are selected, only the reference image is analyzed.

BACKUP COPIES

When this option is checked, Vic-3D will make backup copies of existing output files by replacing their file extension with bak.

OUTPUT DIRECTORY

The directory in which the output files are stored can be selected by clicking the folder icon.



PROJECTED SPECKLE MODE

If this box is present, it can be selected to analyze images where the speckle pattern was projected rather than affixed to the 
surface. For more information, see the projected speckle overview.

SUBSET WEIGHTS

This option controls the way pixels within the subset are weighted. With Uniform weights, each pixel within the subset is considered 
equally. Selecting Gaussian weights causes the subset matching to be center-weighted. Gaussian weights provide the best combination 
of spatial resolution and displacement resolution.

INTERPOLATION

To achieve sub-pixel accuracy, the correlation algorithms use gray value interpolation, representing a field of discrete gray levels as 
a continuous spline.  Either 4-, 6-, or 8-tap splines may be selected here.

Generally, more accurate displacement information can be obtained with higher-order splines. Lower-order splines offer faster 
correlation at the expense of some accuracy.

CRITERION

There are three correlation-criteria to choose from:

        • Squared differences: Affected by any lighting changes; not generally recommended.
        • Normalized squared differences: Unaffected by scale in lighting (i.e., deformed subset is 50% brighter than reference.)
           This is the default and usually offers the best combination of flexibility and results.
        • Zero-normalized squared differences: Unaffected by both offset and scale in lighting (i.e., deformed subset is 10% brighter 
          plus 10 gray levels.) This may be necessary in special situations. However, it may also fail to converge (produce a result) 
          in more cases than the NSSD option.

LOW-PASS F ILTER IMAGES

The low-pass filter removes some high-frequency information from the input images. This can reduce aliasing effects in images 
where the speckle pattern is overly fine and cannot be well represented in the image. (These aliasing effects are often visible 
as a moire-type pattern in the output data.)



USE LEFT STEREO REFERENCE

By default, Vic-3D compares the left to the right image only once: in the initial stereo pair. After this point, succeeding left images 
are compared to the left reference, and succeeding right images are compared to the right reference:

In prior versions, both left and right images from any point in the sequence were always compared to the left reference image:

To force this latter behavior in Vic-3D 2010, check the “left stereo reference” box.

EXHAUSTIVE SEARCH

Enabling this option will cause Vic-3D to repeat a coarse search for matches after each time the correlation fails. This may result in 
more data recovery at the expense of vastly increased processing time.

PROCESSOR OPTIMIZATIONS

This option controls the number of processors/cores Vic-3D uses for analysis. In most cases this will be correctly determined automatically 
by Vic-3D.

THE THRESHOLDING TAB

This tab provides options for removing any data that is bad or suspect while maximizing the amount of retained data. Four thresholding 
options are available. For a typical test, the default values will work very well, but when conditions are unusual or substandard (blur; 



debris; poor lighting; etc), some adjustment may be required.

CONSISTENCY THRESHOLD

After Vic-3D analyzes the seed point, the analysis is propagated to each of its four neighbors, and so on. Each point is fed with 
a prediction of its approximate match. After the match is made, a back-prediction is calculated. If the back-prediction does not 
closely match the actual location of the prior neighbor, this threshold will remove the data.

CONFIDENCE MARGIN

For each match, Vic-3D calculates a statistical confidence region, in pixels, using the covariance matrix of the correlation equa-
tion. If the confidence region exceeds this threshold, the data will be removed.

MATCHABIL ITY THRESHOLD

This option automatically removes subsets that show a very low contrast, i.e, subsets that don’t contain very much information. 
Decrease this value to remove more data; increase to retain more data, i.e., if lighting conditions were poor.

EPIPOLAR THRESHOLD

If a calculated match does not lie very close to the epipolar line, this threshold removes the data. High projection error may be 
caused by motion blur; a poor calibration; or cameras which are not rigidly mounted.

THE POST-PROCESSING TAB

The tab on the dialog displays the following options:



AUTO PLANE F IT

Checking this option will create a coordinate system based on the reference shape. The origin will be at the mass centroid of all 
measured points, with the Z-axis normal to the best-fit plane of the data field.

Leaving this option cleared wil return results in camera coordinates. If custom coordinate transforms are to be used, you should 
always start with camera coordinates to establish a consistent Cartesian reference frame rather than one that may move based 
on the data.

COMPUTE CONFIDENCE MARGINS

Check this box to add metric confidence margins for X, Y, and Z position and displacement. The new variables represent the 
1-standard-deviation confidence for the position, computed from the pixel confidence margin together with the camera geometry.

STRAIN COMPUTATION

Checking this option performs a strain computation as each image is processed; results can be viewed in the preview.

THE MULTI-SYSTEM TAB
The tab on the dialog displays the following options:



MULTI-SYSTEM CALIBRATION

When this option is checked, you can use a different calibration for the deformed images while the main project calibration is 
still used for the reference image. This can be used for correlating from one stereo pair to another pair, i.e., for viewing patches 
around a cylinder. If can also be used when the system must be recalibrated between reference and deformed images.

CALIBRATION

Click to select the project file containing the deformed calibration.

USE MULTISYSTEM NAMING

If this option is checked, deformed output files will be named differently. If the input files are multisystem files generated by 
Vic-Snap (sys1, sys2, etc), the output files will be named for the two systems - for instance, trans_sys1_sys2.out. If the input 
files do not contain a system number, the output file will be named after the reference and deformed images - for instance, 
trans_reference_deformed.out.

IMAGE SCALING

For completing global-local type tests, it may be helpful to work with images which are scaled down by a factor of 2 or 4. If your 
deformed images have been scaled this way, select the appropriate factor; normally, this option will be left at Normal.

CORRELATION RESULTS

After you begin the correlation, the following window appears.



The window contains an overview of correlation progress and results.

File - the progress and total number of files to analyze.

Points - the number of data points calculated for the image.

Time - The amount of time spent on correlation analysis in seconds.

Error - a measure of correlation accuracy (specificially, epipolar projection error). A high number indicates possible problems 
with calibration or camera synchronization.

Iterations - a measure of how many possible matches were searched for each point.

Progress bar- indicates the progress of each individual file as it is correlated.

This window also contains a preview of the output data. This data may be view in 2D and 3D and manipulated as with a standard 
plot.

When the analysis is complete, you may click View Report to see a summary of the above data.

For more information on interpreting correlation results and troubleshooting errors, please contact Technical Support. 



COORDINATE TOOLS
The calculated cloud of XYZ positions and UVW displacements can be modified into a different Cartesian coordinate system, or 
a polar coordinate system, using these options.

        • Apply transformation - applies a previously saved transformation to selected data files
        • Best plane fit - fits the data to the approximate plane of a selected data file
        • Select coordinate system - select an origin, X-axis direction, or XY plane
        • Import from project file - bring in a transform saved in a different Z3D or V3D project file
        • Input manually - enter a transform in terms of angles, or specify a transformation matrix
        • Rigid transform from displacements - calculate a transform from the displacement between two images
        • Compute cylinder transformation - select a polar coordinate system, for nearly cylindrical surfaces
        • Apply cylinder transformation - apply a saved polar coordinate transform

COORDINATE SYSTEM SELECTION
Coordinate system transformations can be selected based on the 3D data contained in the reference data file. To efficiently use 
coordinate transformations, make sure to disable automatic transformation during data analysis; see Coordinate Transformation 
for details. To select a coordinate system, select Data... Coordinate Transformation... Select coordinate system from the main 
menu bar.

 The following dialog will be displayed:



SELECTION METHOD

There four choices to select a coordinate system:

BEST PLANE F IT

Select this option to calculate a transform into the best fit plane of the surface. This is the same as selecting Best Plane Fit from 
the coordinate transform menu.

SELECT ORGIN

Use this option to designate an origin for the coordinate system, while leaving the orientation unchanged. Simply click Select 
Origin, and pick a point in the image. This point becomes 0,0,0 in the x,y,z coordinate system. The orientation of the axes will 
be determined from the best plane fit.

This transform is useful when a specific point in the image is a convenient reference origin, for example, a notch in the specimen.

ORGIN AND X-AXIS

Selecting this option allows the designation of the coordinate origin as well as the x-axis. After selecting, click a point in the 
image to become the coordinate origin. Click a second point to indicate the direction of the positive x-axis. The direction of the 
y-axis will be determined from the best plane fit.

This transform is useful when both a specific origin point and an orientation are desired; for instance, the origin could be a crack 
tip and the axis could be the direction of the crack opening.

3 POINT SELECTION

This option allows selection of an origin and the complete orientation of the axes. Select a point to become the origin. Select 
a second point to indicate the direction of the x-axis. Finally, select a third point to indicate a third point on the xy-plane; this 
will completely define an origin and xyz orientation.

REFERENCE POINT

If desired, enter a coordinate to be designated by the reference point; this will change the point designated by the first click 
from (0,0,0) to the specified coordinates.

Click Accept to calculate the new coordinate transform. The following dialog appears:

Enter a name to add the transform to the current project. At this point you will be prompted to apply this transform to all current 
data files; click Yes to apply or No to leave the data as is.



APPLYING TRANSFORMATIONS
Coordinate system transformations can be applied to data files by selecting the Apply Transformation entry from the Coordinate 
System Transformation menu. The following dialog lets you choose which transformation to apply, and which data files to apply 
the transformation to.

To invert (undo) the selected transformation, check Invert Transformation.

Each transform contains 3 rotation components and 3 translation components. By default, only the rotation is applied to the U, 
V, and W displacement variables; that is, the displacement vectors are rotated with the surface, but their magnitude is unchanged. 
To apply the translation components as as well, altering the displacement vectors’ magnitude, click Displacements only.

Note: if strains are present in the input data, a warning will appear indicating that they will not be transformed. It will be necessary 
to recalculate strain for the x and y components to be correctly aligned with the new coordinate system.



POSTPROCESSING TOOLS
Once the initial position and displacement fields are calculated, several tools are available for processing the data.

        • Calculate strain - calculate surface strain tensors
        • Remove rigid motion - removes overall object motion, leaving only deformation
        • Apply function - apply arbitrary user-defined functions to create new variables
        • Restore data - uses initial triangulation data to recreate original position and displacement field
        • Calculate velocity - uses time information to calculate velocity and strain rate
        • Calculate curvature - calculates local curvature over the surface
        • Calculate in-plane rotation - calculates local surface rotation
        • Smooth - smooths data over a user-specified diameter
        • Map external data - map data from an external source such as an IR camera
        • Delete variables - remove variables created with other postprocessing tools
        • Combine data files - combine multiple data files for display as one
        • Apply math operation - applies simple math operations to discrete variables

STRAIN CALCULATION
To calculate strain for a set of data, select Data... Postprocessing options... Calculate strain from the main menu.



SELECTING DATA FILES FOR PROCESSING 

The available data files are displayed in the Data Files list box. To select which files to process, click on the data file you want 
to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons 
labeled All and None select/deselect all files, while Invert reverses your selection.

PREVIEW

To view the effects of the calculation for a single data file, highlight the file and click the Preview button. You may view the plot 
in 2D or 3D as with a standard data plot.

COMPUTE PRINCIPAL STRAINS

Check this box to add principal strains and principal strain angle to the calculated output data. 

OVERWRITE VARIABLES

Check this option to overwrite any existing strain calculations. If this box is clear, more data fields will be added to the output 
data set each time strain is calculated. 

COMPUTE TRESCA/VON MISES STRAIN

Select these options to compute the Tresca/von Mises strain criterion along with the strain tensor calculation. 

FILTER S IZE/TYPE

Calculated strains are always smoothed using a local filter. The Filter box allows selection of a smoothing method. The decay 
filter is a 90% center-weighted Gaussian filter and works best for most situations; the box filter is a simple unweighted 
averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given in terms of data points rather than 
pixels, the physical size of the window on the object also depends on the step size used during correlation analysis.

TENSOR TYPE

Select the desired strain tensor. The default is Lagrangian finite strain.



REMOVING RIGID MOTION
This tool is used to remove rigid-body displacement from deformed images, leaving only deformation components of displacement.

Once the displacement fields have been calculated from the speckle images, this tool can be started by selecting Data... Remove 
displacements.

DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/deselect. 
This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All and None 
select/deselect all files; the Invert button inverts the selection.

PROCESSING METHOD

To remove all rigid body displacement, select Use average transformation. This will calculate the average transformation for 
each image, and invert it to obtain an image with an average displacement/rotation of 0. Only object deformation will be reflected 
in the transformed U, V, and W displacements. This is useful for visualizing displacement fields in tests where deformation is obscured 
by larger, rigid-body motions.

To keep a single point stationary, select Keep 1 point fixed and click the desired point in the image. Only points within the data



set (highlighted in blue) may be selected. With this method, the selected point will become stationary, with all other displacements 
remaining relative to this point. Any initial rotation will still be present after the operation.

To keep three points stationary, select Keep 3 points fixed; then, click three desired points in the image to define the fixed points. 
With this method, all displacements and rotations will be relative to the three selected points, which will become stationary.  The 
point- and three-point displacement options are useful for, i.e.,  determining deformation of a test subject relative to fixed 
mounting points or standoffs.

If the three points you select are in three different AOI’s, you will be given the option to use the entire AOI for the operation. 
This will be useful if, for example, you have small AOIs on top of three separate fixed posts of a test fixture.

Click Compute to proceed with the computation.

STRAIN CALCULATION

Note that these transforms will not affect calculated strain, nor are they necessary in order to correctly calculate strain; the 
strain algorithm is, by nature, insensitive to rigid-body displacements.

APPLYING FUNCTIONS TO DATA
Vic-3D supports the generation of new variables based on equations applied to the data. This feature can be used, for instance, to 
compute engineering strains from Lagrange strains, to compute stresses from strains or to compute thinning of a strained specimen of 
known thickness based on the Poisson’s effect or volume conservation during plastic deformation.

To apply function to a data sequence, select Data... Postprocessing options... Apply function from the main menu.



FUNCTION

Select a function which you wish to apply to the data.

CONSTANTS

Each function may have constants that are used in its equations. The constants are displayed next to their current values. Some 
constants may contain pre-defined options for the value. Selecting any of the options in the value combo-box will set the constant 
to that value.

CREATING AND EDITING FUNCTIONS AND CONSTANTS

New functions and constants can be created and existing ones can be edited. Click on the Edit... button to open up the Edit 
Functions dialog.

All available functions and constants are listed. Constants local to a function and the outputs of a function are listed underneath the 
function they belong to.

The four buttons underneath the list allow for the creation, editing and deletion of functions or constants. Each of the buttons are as 
follows:

  Opens the wizard to create a new function.

  Opens the wizard to create a new constant.

  Opens a wizard to edit the selected function or constant. If an output is selected it opens the function wizard to the edit outputs 
 page.

  Deletes the selected function or constant. If an output is selected it delete the function it belongs to.

Double-clicking on any item in the list will open the respective wizard for editing.

SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the list box on the bottom left of the dialog. To select which files to process, click on the data file 
you want to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons 
labeled All and None select/deselect all files, while Invert reverses your selection.

PREVIEW

To view the effects of the calculation for a single data file, highlight the file and click the Preview button. You may view the plot in 2D 
or 3D as with a standard data plot.



CREATING AND EDIT ING FUNCTIONS
FUNCTION INFORMATION

The first page of the function wizard is for entering a brief description of the function and the scope in which the function is 
stored. The Global scope option stores the function in the program settings where it can be used by any project. The Project 
stores the function in the project itself. If the project option is selected, then the function and it’s local constants are stored in 
the current project and is only accessible by the current project.

DEFINE OUTPUT VARIABLES

Every function must have at least one output variable. The output variable is the information that is stored in the data files of 
the project. To add one, simply click Add an output... There are two things to be entered for each output. The first is the actual variable 
itself as used in equations. The second is a brief description of the variable - this will be displayed in plot context menus. The 
‘X’ icon is the delete button. Clicking it will delete the associated output.



CREATING AND EDIT ING CONSTANTS
CONSTANT INFORMATION

The label defines what is to identify a given constant in an equation. The scope defines whether or not the constant is accessible to 
all functions (Global) or if it is only accessible to a specific function. The description is used to note the purpose of the constant.

DEFINE OPTIONS

Defining options is not necessary but it can be helpful; for instance, a preselected group of material property constants, as in 
the example below. There are two values for each option: a description and a value.



RETRIANGULATING DATA
After data has been manipulated through math operations or postprocessing, it is possible to restore the initial position and 
displacement field without rerunning the correlation. To start, select Restore data from the postprocessing menu or toolbar. 

DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files; the Invert button inverts the selection.

POSTPROCESSING

This tab contains the same postprocessing options as the initial Run dialog. Select the coordinate transform, confidence margin 
option, and strain calculation here.

To complete the operation, click Start to restore the data.

CALCULATING VELOCITY
Vic-3D can calculate rates for displacement and strain, using either a specified time interval or time retrieved from a .CSV log 
file.

Once the displacement fields have been calculated from the speckle images, velocities may be calculated by selecting the Calculate 
Velocity entry on the Data menu. (If strain rates are desired, strain should be calculated before opening the Calculate Velocity 
dialog.) This will display the dialog shown in the figure below.



DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files; the Invert button inverts the selection.

VELOCITY CALCULATION

If a Vic-Snap .CSV log file exists for the project, you may select “Time From File” from the dropdown and select the file, if necessary. 
Otherwise, select “Constant Time Step” and enter the known time increment, or select “Constant Frame Rate” to enter a known 
frame rate, for, i.e., a high-speed camera.

Click Start to begin; the progress bar will indicate completion. For each strain and displacement variable in the dataset, a derivative 
in time will be added and can be viewed as a contour overlay.

CURVATURE CALCULATION
To calculate local curvature for a set of data, select Data... Postprocessing options... Calculate Curvature from the main menu.

Please note that this function returns values of 1/D and not 1/r. This will result in a factor of 2 difference from the conventional measure.



SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the Data Files list box. To select which files to process, click on the data file you want 
to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons 
labeled All and None select/deselect all files, while Invert reverses your selection.

PREVIEW

To view the effects of the calculation for a single data file, highlight the file and click the Preview button. You may view the plot 
in 2D or 3D as with a standard data plot.

CALCULATING PRINCIPAL CURVATURES

Check this box to add principal curvatures to the x/y curvature data. 

OVERWRITE VARIABLES

Check this option to overwrite any existing curvature calculations. If this box is clear, more data fields will be added to the output 
data set each time strain curvature is calculated.   

FILTER S IZE/TYPE

Calculated curvatures are using a local filter. The Filter box allows selection of a smoothing method. The decay filter is a 90% 
center-weighted Gaussian filter and works best for most situations; the box filter is a simple unweighted averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given in terms of data points rather than 
pixels, the physical size of the window on the object also depends on the step size used during correlation analysis.



ROTATION CALCULATION
To calculate local in-plane rotation for a set of data, select Data... Postprocessing options... Calculate in-plane rotation from 
the main menu.

SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the Data Files list box. To select which files to process, click on the data file you want 
to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons 
labeled All and None select/deselect all files, while Invert reverses your selection.

PREVIEW

To view the effects of the calculation for a single data file, highlight the file and click the Preview button. You may view the plot 
in 2D or 3D as with a standard data plot.

OVERWRITE VARIABLES

Check this option to overwrite any existing rotation calculations. If this box is clear, more data fields will be added to the output 
data set each time rotation is calculated. 

FILTER S IZE/TYPE

Calculated rotations are smoothed using a local filter. The Filter box allows selection of a smoothing method. The decay filter is 
a 90% center-weighted Gaussian filter and works best for most situations; the box filter is a simple unweighted averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given in terms of data points rather than 
pixels, the physical size of the window on the object also depends on the step size used during correlation analysis.



SMOOTHING DATA
To calculate strain for a set of data, select Data... Postprocessing options... Smooth variable from the main menu.

SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the Data Files list box. To select which files to process, click on the data file you want 
to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons 
labeled All and None select/deselect all files, while Invert reverses your selection.

PREVIEW

To view the effects of the calculation for a single data file, highlight the file and click the Preview button. You may view the plot 
in 2D or 3D as with a standard data plot.

FILTER S IZE/TYPE

Data is smoothed using a local filter. The Method box allows selection of a smoothing method. The decay filter is a 90% center-weighted 
Gaussian filter and works best for most situations; the box filter is a simple unweighted averaging filter.

The Filter size box controls the size of the smoothing window. Since the filter size is given in terms of data points rather than pixels, the 
physical size of the window on the object also depends on the step size used during correlation analysis.

Note: by default, 3D plots display deformed data - the sum of each point’s X,Y,Z location and its U,V,W displacement. Because of this, 
creating a smooth 3D plot like the one above requires smoothing both Z and W.



MAPPING EXTERNAL DATA
The software supports mapping of externally acquired data from calibrated area sensors onto data files, e.g., to provide full-field 
temperature distribution data using infrared cameras. The mapping process requires a calibration for the external camera that 
is properly registered with the stereo system calibration. In order to ensure that the external camera is registered to the same 
coordinate system, at least one of the calibration target images must be acquired in the same orientation and chosen as the 
reference during the calibration process. See camera calibration for details.

To map externally acquired area data onto a data sequence, select Data... Postprocessing options... Map external data from 
the main menu or click          on the toolbar.

AUTOMATIC OPERATION

If IR images were acquired using Vic-Snap, images will be detected and the parameters set automatically. The last image will be 
previewed and you will be prompted to run the data.



DELETING VARIABLES
User-generated variables can be deleted from data files. Note: Use this functionality with caution. Once removed, variables 
cannot be restored other than by reprocessing.

To remove variables from data files, select Data... Postprocessing options... Map external data from the main menu.

SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the list box on the left of the dialog. To select which files to process, click on the data 
file you want to select/deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, 
the buttons labeled All and None select/deselect all files, while Invert reverses your selection.

SELECTING VARIABLES

The available variables are listed in the list box on the right of the dialog. Note that only user-generated variables can be deleted. 
Select the variables you wish to remove by clicking on the variable name. This will toggle a check mark indicating whether the 
variable will be removed or not.

RESCANNING VARIABLES

If the data files do not all contain the same variables, the variable you are trying to remove may not appear in the list box when 
the dialog is shown. In this case, highlight the data file that contains the variable you wish to remove in the data file list box by 
clicking on it. Then, press the Rescan button to repopulate the variable list box based on the variables contained in the selected 
data file.



TIME F ILTER
Time filters can be used to filter the full-field data along the time axis. Currently, filters for removing outliers and for smoothing 
are provided. The time filter dialog provides the ability to select multiple filters to create a filter chain. This can be used to, e.g., 
to remove outliers and smooth data in a single pass. The time filter dialog is shown in Figure 1.

To apply time filters to a data sequence, select Data... Postprocessing options... Time filter from the main menu.

             Figure 1: Time filter dialog.

VALIDATION

On startup, the time filter dialog validates the data files in the project. A progress bar in the bottom left corner indicates the 
progress of this operation. For projects with a large number of data files, this process may take some time to complete.

PREVIEW

The time filter dialog can provide a preview that is updated in real time. This preview is available if inspector points, discs or 
rectangles have been added to any of the contour plots in the project. Note that the preview only becomes available after validation 
of the input files and after a variable for filtering has been selected.

VARIABLES

In the variable box, one or more variables can be selected to which the filters are applied. The Replace variables check box can 
be used to overwrite the existing variables with the filtered results instead of creating new variables. The Add filter names to 
variables check box indicates whether the variable names of the filtered data should contain a description of the filter chain 
or not.

FILTER SELECTION AND FILTER CHAINS

The type of filter to be applied can be selected in the drop-down box in the top-left corner of the dialog. By clicking the Add 
button, a second or third filter can be added to the filter chain. The Remove button can be used to remove an unwanted filter 
from the filter chain. Note that the filters are applied in the order they are added, as indicated by the number for the filter displayed



on the tab bar.

BIONOMIAL F ILTER

The binomial filter is useful to apply moderate amounts of smoothing to the data. The binomial filter is a simple convolution filter. For 
a filter size of 3, the convolution mask is 1/4[1 2 1], and the larger filter masks can be obtained by repeated convolution of this mask 
with itself. The filter options for the binomial filter are shown in Figure 2.

      Figure 2: Binomial filter.

MEDIAN FILTER

The median filter is useful for removing outliers from the data. The filter computes the median value in a neighborhood with user selectable 
size (see Figure 3). If the median filter is used in a filter chain, it should always be selected as the first filter.

      Figure 3: Median filter.

RECURSIVE LOW-PASS F ILTER

The recursive low-pass filter can be used to efficiently provide a large amount of smoothing. As can be seen in Figure 4, the filter provides 
a user-selectable cut-off frequency and order. The cut-off frequency is the (normalized) frequency at which the transfer function has a 
value of 50%. The order determines the steepness of the fall-off. Note that for very low cut-off frequencies, this filter does not preserve 
the mean value of the data.

      
  
              Figure 4: Recursive low-pass filer.



SPLINE F IT F ILTER

The spline fit filter can be used to provide large amounts of smoothing. Depending on the order of the spline (linear, quadratic 
or cubic), this filter fits a curve consisting of multiple segments with c0, c1 or c2-continuity between the segments. The lower 
the number of segments, the more smoothing is accomplished. Note that the number of segments must be lower than the 
number of data points. The options panel for the spline fit filter is shown in Figure 5.

    
      Figure 5: Spline fit filter.

TIME AVERAGING DATA
The Time Averaging dialog is used for dealing with data which requires time averaging to eliminate certain biases or provide extra 
accuracy.

This functionality is designed to work with data which has been acquired in a specific way: for each specimen state, n image pairs 
should be acquired. For instance, 10 images taken at the reference state, 10 images taken at the first load step, etc. Next, the data 
including all images should be analyzed as usual. With the data below, we have taken 5 images at each of 8 load states, including the 
reference state.

Once the data is calculated from the speckle images, click Data... Postprocessing tools... Time Average Data on the main menu.



OPTIONS

If the First group as reference box is checked, the first set of data will be averaged to create a new reference configuration; 
then, this reference configuration will be subtracted from later groups, in effect re-referencing all of the data to a new, averaged 
meta-reference image.

The Group size indicates the number of images taken at each stage. Only divisors of the data file count may be selected so it is 
important that the correct number of input data files are present (an even multiple of n from above).

The new data files are prefixed with the selected Output prefix.

SELECTING FILES

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files; the Invert button inverts the selection.

To begin the computation, click the Start button.

RESULTS

Once the computation is finished, a new set of averaged data files will appear in the project under Other data.

These data files contain the time averaged (and re-referenced, if selected) data. For plotting purposes, each averaged file is 
linked to a single input image so that 2D plots will display correctly.

USAGE NOTES

The time average function can be used for any data that is noisy over time. Examples would include data which has pixel noise 
due to low light/high gain, as well as data which is corrupted by refractive heat waves. The specimen itself should be in exactly 
the same position for each of the n images to avoid any bias; ideally, the only thing changing within an image set is the relevant 
noise.



COMBINING DATA
To combine data files or groups of data files, select Data... Postprocessing options... Combine data from the main menu.

SELECTING DATA FILES FOR PROCESSING

The available data files are displayed in the Data Files list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All and 
None select/deselect all files, while Invert reverses your selection.

This dialog operates on data files present in the project; if you don’t see the ones you want, close the dialog and click Project... Data 
files from the main menu to add them.

PREVIEW

To view an individual data file, click the file in the Data files list. To see a preview of the combined data files, click the file in the tree 
view below.



COMBINE PREFIX

This field controls the name of the new data files. When files are grouped, the sequence number will be added; otherwise, this 
will be the entire filename.

OUTPUT DIRECTORY

Click the icon to select a new output path for the files.

COMBINING F ILES
To begin, click Start. The files will be combined and added to the existing project file.

MATH OPERATIONS
The Math operations dialog allows manipulation of output data by basic math operations. Open this dialog by selecting Data... Math 
Operations from the main menu bar.

DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/deselect. 
This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All and None select/
deselect all files; the Invert button inverts the selection.

OPERATION

Choose Add, Subtract, Multiply, or Divide to perform the specified operation.



ARGUMENTS

The Variable box is used to select the variable to operate on. Any variable in the data set may be selected.

To use a constant argument, select the Constant radio button and enter the value. For example, the selections below will multiply 
the W-displacement value from each data file by 10.

To use the data from an output file, click Data and select a data file. For example, the selections below will subtract the Z shape from 
the first data file, from all data files.

Click Start to begin; the progress bar will indicate completion. For each strain and displacement variable in the dataset, a derivative in 
time will be added and can be viewed as a contour overlay.



EXPORT OPERATIONS
Calculated position and displacement data, along with transformed and postprocessed variables, can be exported via several 
different options:

        • All data - export entire data set
        • Pixel grid data - sample data set on a pixel grid
        • Metric node data - place surface nodes using metric coordinates, for FE comparisons
        • Aggregate statistics - export mean, median, deviation, min, max for selected files and variables

EXPORT DATA
For efficient file access, Vic-3D stores results in a binary data file format. To use the data with other programs for post-processing 
and plotting, the data can be exported by selecting the Export item from the Data menu.

The dialog shown below will be displayed.

SELECTING FILES FOR EXPORTING

The available data files are displayed in the list box. To select which files to export, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files.

FILE FORMATS

The data files can be exported to the following formats:



COMMA-SEPERATED VARIABLE

Data entries are separated by commas. This format is understood by most spreadsheet programs and plotting packages. Variable 
names are stored in the data file as comma-separated strings in quotation marks. Exported files will have the extension csv.

TELCPLOT

Used for plotting the data with Amtec’s (www.amtec.com ) plotting program Tecplot(TM). Exported files will have the extension 
dat.

PLAIN ASCI I

This format is plain, space-delimited ASCII text data with one data point per line. Note: There are no variable names in the data 
file, and data from different AOIs is concatenated. Exported files will have the extension txt.

STL FORMAT

This format provides a triangulated surface compatible with many CAD programs.

MATLAB V4

This format provides compatibility with Matlab and many other programs capable of reading Matlab files. Note that if multiple 
AOIs are present in a datafile, unique names for each of the matrices are generated by appending increasing numbers to the 
variable names. For instance, the X-coordinate for the first AOI will appear as X in the matlab file, and for the second AOI it will 
appear as X_0 and so forth.

If none of the available file formats fit your needs, please contact support@correlatedsolutions.com. We will gladly implement 
data exporting to a format that best suits your needs.

EXPORTING GRID-BASED DATA
This option can be used to export your data, sampled at regular intervals spatially and for each data file, to a single text file. To begin, 
select Export Grid Data from the Data menu.



DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files; the Invert button inverts the selection.

OPTIONS

To change the sample interval in pixels, adjust the Sample step value. A value of 1 will sample every pixel; higher values will 
result in a sparser data set.

To export blank values to the output file, with a value of 0, check the Export blanks box. If this box is cleared, blank data points 
will not be present in the output file.

EXTRACTING DATA

To begin, click Start. You will be prompted for an output .csv file name. A progress bar will appear; when extraction is complete, 
the dialog will close.

EXTRACTING NODE DATA
This option can be used to export spatially sampled data to one or more CSV files.



ADDING SAMPLE POINTS

Exported data is sampled based on X, Y coordinates. You can add a single point at a time, or a line, circle, or grid, by clicking 
on the appropriate button. This can be repeated as many times as desired to add as many points as necessary. Points on the 
surface will be displayed as green markers; points which do not fall on the surface for a given data file are shown as red.

To save a set of points for future use, click the disk icon next to the file dropdown. To restore from an existing file, use the file dropdown, 
or select Add File.

DATA F ILES

Use this list to select one or more data files to extract from.

VARIABLES

Select the desired output variables from this list.

USE DEFORMED COORDINATES

To overlay the selected X, Y points on the deformed shape, check this box. To overlay the coordinates on the initial shape (while still 
exporting deformation data), clear the box.

PREVIEW AND EXPORT

Click Preview to see the position of your points on the selected file. To export the data according to your selected points, click Export.



CALCULATING STATISTICS
To export statistics for calculated variables and data files, select Data... Statistics from the main menu bar.

STATISTICS

Check the desired item to include or exclude the statistic from the output file.

VARIABLES

Check the desired variables to add them to the calculation. By default, all metric variables are included, while correlation and 
pixel variables are excluded.

DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/
deselect. This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All 
and None select/deselect all files; the Invert button inverts the selection.

EXPORTING

To complete the calculation, click Ok. You will be prompted for a filename, and the data will be exported as a .CSV file.



PLOT TING DATA
Data can either be visualized as a three-dimensional plot with or without color contour overlay, or as a two-dimensional contour 
plot overlayed over the speckle image. The two-dimensional plot provides facilities for extracting data from sequences, as well 
as extracting slices of data.

    
           3D Plot             2D Plot

OUTPUT VARIABLES
INTRODUCTION

During correlation and optional post-processing, Vic-3D presents a wide range of output data available for 3D and contour 
plotting, extraction, and export.

OUTPUT VARIABLES
  ALWAYS PRESENT

        •X [mm] - metric position along the X-axis (by default, the horizontal axis).
        •Y [mm] - metric position along the Y-axis (by default, the vertical axis). Z [mm] - metric position along the Z-axis (by default, 
             the out-of-plane axis).
        •sigma [pixel] - this is the confidence interval for the match at this point, in pixels.
        •x  / y [pixel] - point location in the reference speckle image
        •U [mm] - metric displacement along the X-axis, from the reference image. For the reference image, displacement values 
         will always be 0.
        •V [mm] - metric displacement along the Y-axis.
        •W [mm] - metric displacement along the Z-axis.
        •u / v / q / r [pixel] - internal raw disparity measures.

GENERATED IN POSTPROCESSING 
  STRAIN VARIABLES

        •exx [1] - strain in the X-direction. Positive numbers indicate tension; negative numbers indicate compression.
        •eyy [1] - strain in the Y-direction.
        •exy [1] - shear strain.
        •e1 [1] - the major principal strain.
        •e2 [1] - the minor principal strain.
        •gamma [1] - the principal strain angle in radians, measure counterclockwise from the positive X-axis.



VELOCITY VARIABLES

        •dU/dt [mm/s] - the rate of change of the U-displacement; that is, the velocity of a given point in the X direction.
        •dV/dt [mm/s] - velocity in the Y direction.
        •dW/dt [mm/s] - velocity in the Z direction.
        •dExx/dt [1/s] - the rate of change of strain in X, or strain rate in X.
        •dEyy/dt [1/s] - the strain rate in Y.
        •dExy/dt [1/s] - the shear strain rate.

CURVATURE VARIABLES

        •cxx [1/mm] - curvature in the X-direction, equivalent to 1/(diameter of curvature).
        •cyy [1/mm] - curvature in the Y-direction.
        •c1 [1/mm] - the major principal curvature.
        •c2 [1/mm] - the minor principal curvature.
        •gamma [1] - the principal curvature angle in radians, measured counterclockwise from the positive X-axis.

ROTATION VARIABLES

        •phi [1] - the in-plane rotation, in radians.

KEY TERMS

Strain: the change in length, divided by initial length, for a solid material. For example, a strain of +10% indicates that the material 
has expanded by 10%; a strain of -10% indicates that the material has contracted by 10%. Positive strains are referred to as 
tensile, while negative strains are compressive. Note: this is a finite strain tensor and contains a quadratic term; for significant 
strains, this may result in a strain measure which is larger than the small strain indicated by a strain gauge or extensometer. 

Principal strain: the strain for a reference frame that is rotated such that shear becomes zero, leaving only two strain components 
at 90° angles. The larger strain becomes the major principal strain, and the smaller becomes the minor principal strain.

THE PLOT TOOLBAR
The plot toolbar is displayed at the top left edge of the work area by default. It contains options and controls for both the 2D and 3D 
plots.

 
AUTO-SCALING



This tab controls auto-scaling. Check or clear the boxes to enable auto-rescaling of either coordinate axes limits, or contour 
overlay limits. Check Grow ranges only to allow ranges to get larger but not smaller. With this box checked, you can animate 
through all images to set the limits to the minimum and maximum over all data files. This is useful for producing consistent 
animations and videos.

AXES

This tab allows selection of axis limits and Z-scaling, when auto-scaling is turned off. To control the scaling of the Z-axis relative 
to the X- and Y-axes, change the Z-scale value. Larger numbers will exaggerate the Z-axis more.

CONTOUR

This tab allows control of the contour overlay of 2D or 3D plots. To automatically scale these values to fit the data, check the 
Auto-rescale contour box. To manually set the limits, clear this box and enter the desired values.

To enable or disable the contour overlay in 3D mode, select Show contour plot.

Use the strain unit control to determine how strain values are displayed; the default is unity, i.e., mm/mm.

COLOR



Use this tab to control the display of contour overlays. The Color map box chooses the overall color set for the plot. The Opacity box 
sets the opacity of the overlay; this option affects 2D plots only. The Levels box sets the n box sets the number of discrete contour 
levels. The Level labels box controls the number of numeric level indicators.

ISO-L INES

Use this tab to display iso-lines on the contour plot.

If many levels are present, you can increase the Level skip to reduce clutter. The thickness of the isolines and the color can also 
be adjusted.



VECTOR

This tab controls display of strain and displacement vectors.

Major and minor strain direction vectors are displayed on 2D plots only, when strain data is available; displacement vectors 
may be viewed in 2D or 3D. Skip and scale control the size and density of the vectors. The use solid color checkbox causes the 
vectors to be displayed in a single color rather than the underlying plot color; the color selector button can be used to choose 
this color.

LEGEND

These controls affect the format of the contour legend. Select a Format from Number, Scientific (exponential notation), or Best 
(most concise method). Select a number of Digits, or Automatic to use as much precision as necessary.



3D PLOTS
A 3D plot of the data can be displayed by double-clicking on a data file in the list view to the left of the workspace or by selecting a 
data file from the Data... Plot menu.

A plot will be displayed in the workspace as shown below.

CONTROLLING THE PLOT

To rotate the plot, click and drag in the plot window. To zoom in and out, rotate the scroll wheel. To pan around the plot, click and hold 
the scroll wheel and move the mouse.

PLOT OPTIONS

Plot options can be accessed by right-clicking in the plot window.



To switch to a 2D plot, select Show 2D Plot from the context menu, or click 2D in the main toolbar.

Use the View submenu to select a planar view or revert to the default view.

The Contour variable submenu can be used to select the variable to display.

Click Change legend orientation to toggle between a horizontal and vertical legend.

Copy copies the current plot to the clipboard; Save allows saving the plot as an image file.

Select Export video to save an animated video.

Click Detach to keep this plot static instead of updating it each time a new data file is clicked in the Data tab.

EDITING PLOT PARAMETERS

To edit other plot parameters, use the plot toolbar.

ANIMATING PLOTS

To animate 3D plots, bring up the plot display and then use the controls on the Animation Toolbar to animate the sequence.

SAVING THE PLOT

The displayed plot can be saved as a BMP, PNG, or JPG image file by selecting Save from the context menu. To copy the plot to 
the clipboard, select Copy.



2D PLOTS
A 2D plot of the data can be displayed by double-clicking on a data file in the list view to the left of the workspace, and then 
clicking 2D in the main toolbar or clicking Show 2D plot in the plot context menu.

A plot will be displayed in the workspace as shown below.

PLOT OPTIONS

Plot options can be accessed by right-clicking in the plot window.



The Contour variable submenu can be used to select the variable to display.

 To switch to a 3D plot, select Show 3D Plot from the context menu, or click 3 D in the main toolbar.

Click Show camera 2 to change the underlying speckle image to the other camera view.

The Show min. value and Show max. value options will flag the minimum and maximum valued data points.

By default, data is displayed in the deformed location on the deformed image. To show the reference position for the data, click 
Show reference data.

Click Change legend orientation to toggle between a horizontal and vertical legend.

Click Statistics to view a summary of data for the current image, for the currently selected contour variable.

Copy copies the current plot to the clipboard; Save allows saving the plot as an image file.

Select Export video to save an animated video.

Click Detach to keep this plot static instead of updating it each time a new data file is clicked in the Data tab.

EDITING PLOT PARAMETERS

To edit other plot parameters, use the plot toolbar.



INSPECTOR TOOLS

Tools for probing and extracting data are located in the Inspector Toolbar, and can also be selected by clicking Plot... Inspector 
in the main menu bar.

From left to right, the tools are:

        •Pan/Select: Pans around the contour image, when zoomed in; selects existing extract points. To select an item, click on the small 
          square handle.
        •Inspect point: select this tool and click to probe at a single point. The value for the currently selected contour variable, at the 
          chosen point, will be displayed.
        •Inspect line: select this tool and click once to start a line; click again to finish. The value will be displayed at each node.
        •Inspect polyline: select this tool and click to create line nodes; double-click to finish. The value will be displayed at each node.
        •Inspect polygon select this tool and click to define a polygon. Values will be displayed at each node; the average will be extracted.
        •Inspect circle: select this tool and click to define a center; click again to define a disc. The average value will be displayed at the 
          center node.
        •Inspect rectangle: select this tool and click to define a center; click again to define a rectangle. The average value will be displayed 
         at the center node..
        •Extensometer: select this tool and click two points; this tool shows the extension (change in length divided by initial length) 
           between the two points.
        •Delete: choose this tool and click on an existing point/line/area to remove it.
        •Extract: click to open the Extraction dialog. 

Once a tool is selected, you can place it on the plot by clicking.

        •For the point tool, click once to place the point.
        •For the circle, rectangle, and line tools, you can click once to place the first point, and again to define the shape.

Once a tool is placed, you can use the Pan/Select tool to move the inspector or to adjust the control points.

ANIMATING PLOTS

To animate contour plots, bring up the plot display and then use the controls on the Animation Toolbar to animate the sequence.

SAVING THE PLOT

The displayed plot can be saved as a BMP, PNG, or JPG image file by selecting Save from the context menu. To copy the plot to the 
clipboard, select Copy.

Exporting Videos

To export an animation from a 2D or 3D plot, right-click in the plot and select Export Video.

If the auto-rescaling feature is enabled for contours or axes, you will see a warning:



EXPORTING VIDEOS
To export an animation from a 2D or 3D plot, right-click in the plot and select Export Video.

If the auto-rescaling feature is enabled for contours or axes, you will see a warning:

When rescaling is on, the animation may not appear as expected because each frame will be scaled differently. Click Yes to continue or 
Cancel  to correct the condition.  When complete, the following dialog appears:

FILE

Click the icon to select a filename for saving.

ENCODER

To use the built-in codecs, select AVI.
To use a choice of external codecs with a supported external encoder, select External converter.
Select Image Sequence to export a sequence of numbered individual images rather than a video.

FORMAT

Select from available compression formats; options will vary based on system configuration and installed codecs.

For videos which will be recompressed, select RGB Uncompressed to make a very large but lossless video.

DATA FILE SELECTION

The available data files are displayed in the list box. To select which files to process, click on the data file you want to select/deselect. 
This will toggle the check mark indicating whether the file is selected or not. For convenience, the buttons labeled All and None select/
deselect all files; the Invert button inverts the selection.

To begin, click Export; a progress bar will indicate completion.



EXTRACTING PLOTS
Extraction plots can be generated for the dataset as a whole, or for lines, points, and areas by using the Inspector Tools in a 2D plot.

        • Average data will always be available for time plotting; placed inspector tools will also be selectable.
        • Line slice plotting will only be available if line or polyline has been selected.

POINT DATA EXTRACTION AMD PLOT TING
The data plot appears when the Extract button (        ) is pushed while viewing a 2D Plot.

SELECTING L INES TO PLOT

By default, a line will be created for the average, and another for each placed point, disc, rectangle, or extensometer.  To add, 
remove, or change a line, you can use the Extraction Tools at the top left.



To modify a line’s variables, you can change both the variables and the data source for the Y and X axes. Available data sources are:

        •Average (the average for the entire plot) 
        •P0/R0/etc (the values at your selected inspector tools);
        •Analog (select from any analog values present)

Once you make a change, click the enter button to the right of the axis controls to apply.

To delete a selected line, click the line and then click the Delete button.

To add a new plot, click the New item in the line list at the top. Make your selections, and click Add to add the line.

To export plot data, click Export to bring up the Export data wizard.

NAVIGATING IN THE PLOT

Use the mouse wheel to zoom in or out on the plot. Click and drag to pan; double click to fit the plot to the window.

To adjust a single axis scale, mouse over that axis; the cursor will change to indicate the axis is active. Then, use the mouse 
wheel to zoom only that axis.

To zoom to a selected box, hold the shift key and drag to indicate the zoom area.

THE CONTEXT MENU

Right-click in the plot to access options.

        • Cursor: select from axis indicators for X, Y, or both axes; select Snap Cursor to display the value reading closest to the cursor.
        • Copy: copies the plot to the clipboard.
        • Save: select to save the plot as a graphics file.
        • Settings: click to access the plot settings.
        • Quick help: display a brief overview of the plot navigation controls.

L INE SL IC ING EXTRACTION AND PLOT TING
Line slices may be plotted only when an extraction line or polyline is present; use the Inspector Tools to create these lines in a 2D plot view:



Click the Extract button (       ) to bring up the plot window. Then, select Line slices from the plot type pulldown.

On the plot, you will see a series of lines representing the extracted data at different times. (If you have many images, not every image 
will be represented with a line by default). The line for the currently selected data file will be highlighted:

SELECTING VARIABLES

To modify a line’s variables, you can change both the variables and the data source for the Y and X axes. For the data source, you can 
select from any lines that are drawn on the image, if more than one.

Once you make a change, click the enter button to the right of the axis controls to apply.

To delete a selected line, click the line and then click the Delete button.

To add a new plot, click the New item in the line list at the top. Make your selections, and click Add to add the line.

THE CONTEXT MENU

Right-click in the plot to access options.



        • Cursor: select from axis indicators for X, Y, or both axes; select Snap Cursor to display the value reading closest to the cursor.
        • Copy: copies the plot to the clipboard.
        • Save: select to save the plot as a graphics file.
        • Settings: click to access the plot settings.
        • Quick help: display a brief overview of the plot navigation controls.

EXTENSOMETER EXTRACTION AND PLOTTING
Extensometer plotting will be available when one or more extensometers have been created using the Inspector Tools in a 2D 
plot view:

Click the Extract button (        ) to bring up the plot window. Then, select Extensometers from the plot type pulldown. (If both points 
and extensometers are present, you will also be able to select Points and extensometers to show both on the same plot.)



The plot will show a line for each extensometer, indicating extension:

SELECTING VARIABLES

To modify a line’s variables, you can change both the variables and the data source for the Y and X axes. For the data source, 
you can select from extensometers (E0, E1, etc) or Analog if analog data is present in the project.

The available extension variables are:

        • ΔL/L0: The change in length divided by the initial length; unitless.
        • ΔL: The change in length, in display units.
        • L1: The deformed length, in display units.
        • L0: The initial length, in display units.

Note: the strain displayed here will not necessarily match the strain computed in the Strain dialog, depending on the tensor you 
have selected. The extensometer strain is a simple length calculation and does not account for bending, etc.

Once you make a change, click the enter button to the right of the axis controls to apply.

To delete a selected line, click the line and then click the Delete button.

To add a new plot, click the New item in the line list at the top. Make your selections, and click Add to add the line.

PLOT SET TINGS
To access settings, right-click in the plot and click Settings.



The first tab controls graph display settings.

        • Graph style: select from lines, points, or both. If Points is selected, you can use the snap cursor to evaluate values at specific 
          locations in the plot. With Lines selected, the snap cursor will give an interpolated value.
        • Show legend: click to show or hide the legend.
        • Legend position: select the location of the displayed legend on the plot.
        • Theme: choose from a cheerful white “Daytime” background, or a slightly more edgy “Midnight” theme.

The second tab applies to time extraction only. You can select whether to highlight the currently displayed data file; and select 
which data files to plot. All are plotted by default.



The third tab applies to line sliceextraction only.

Under Mode, you can choose to display lines for the current file and the select files; only the current file; or only the selected 
files (select files from the list below). You can also adjust the style of the non-selected lines as well as the color for them.

Select the files to be extracted from the list at the bottom.

By default, 200 points are created along the extracted line. Since the line does not necessarily pass through exact data points, 
we interpolate an arbitrary number of points; click Change to select a different quantity.

EXPORTING DATA
To export data, click Export in the Extraction tools. The Export data wizard will appear.

        • Output file: click the folder icon to choose an output file.
        • Data type: choose from line slice or time extraction.
        •  Format: select from comma separated (typical for use with Excel) or tab separated.
        • Ordering: select row index to have a row for each file (most common), or column index to have a column for each file (useful for 
           making waterfall type plots).
        • Coordinates: if you select reference coordinates, the XYZ values will not change over time. Select deformed coordinates to add 
           UVW deformation to the XYZ values, making them change with time.



CREATING REPORTS
To create a report after running an analyis, click File... Report from the main menu.

You can choose from installed Text documents or Presentations by selecting the tab at the top. The preset location for these 
templates is under your Documents folder in the VicReportTemplates subfolder. Supported filetypes are:

        • .odt: OpenDocument document.
        • .docx:  Microsoft XML document.
        • .odp: Open Document presentation.
        • .pptx: Microsoft XML presentation.

You can add to the template library by placing new templates in this folder. Click on a template to continue, or click Other to 
select any other file. 

Important note: if a tag is broken up by formatting, revision tracking, or spell checking, it will not be processed. It is usually best 
to turn off all change tracking and spelling/grammar checking in your word processor.



REPORT OPTIONS

IMAGE RESOLUTION:

        • Screen: for plots/images, uses the same resolution as the display, for viewing on screen.
        • Print: upscales images for a better printed image.

SCALING:

In Print image resolution, choose nearest neighbor (faster) or smooth (better quality).

VIDEO SET TINGS:

        • Encoder: choose encoding method (built in AVI or external convertor).
        • Format: choose a preset format (faster, higher quality, etc).
        • Frame rate: select a frame rate for video display.

To open the report after completion, leave the checkbox selected. Click Ok to begin; the document will be filled out, replacing 
tags with quantities, images, tables, and videos. For more detail on available tags, consult the Report Template Tags reference.



TEMPLATE TAG REFERENCE
BASICS

To insert a text tag, place the tag and any parameters, separated by commas, inside braces.  The tag will be replaced by the 
appropriate value without changing the font, position, etc. For example, {@VIC_RIG_TX}.

To insert a graphic tag, create a blank or placeholder image and then add the tag and any parameters as the alternative text. 
The image will be replaced by the requested plot. For example, {@VIC_PLOT_3D,var=e1,idx=-1}.

Important note: if a tag is broken up by formatting, revision tracking, or spell checking, it will not be processed. It is usually best 
to turn off all change tracking and spelling/grammar checking in your word processor.

Format specifiers:

Many tags have format specifier flags.

         fmt: floating point format
               • ‘f’: display as [-]7.7
               • ‘g’: display as [-]7.7E[+|-]777 when more concise

        prec: precision specifier (number of digits after decimal for ‘f’ or total number of floating point digits for ‘g’)

Spreadsheet column specifiers have the format COL_ID:FMT:PREC, where

COL_ID: spreadsheet column (A, B, C, ..., AA, AB etc.)
FMT: number format ‘f’, ‘g’ (optional)
PREC: number of digits (optional)

List indeces:

Any time a list index idx is present, you may specify integer values starting from 0, or negative values to count down from the end; e.g., 
-1 refers to the last element. Alternatively, indeces can be specified as a percentage, e.g., 33.33%. If indeces are specified as percent-
ages, the closest integer value is used.

TAG CATEGORIES

VIC_ADATA:

        Used to insert data from the project’s analog data file (CSV) for time, load, etc.

        idx: Index value
        col: column (A, B, C, ..., AA, AB)
        fmt: floating point format (‘g’, ‘f’)
        prec: precision specifier (number of digits)

        Example: {@VIC_ADATA, idx=100%, col=B, fmt=’f’, prec=1}  - shows the second column (normally Time_0) from the analog data file 
        for the last image in the test, floating point, 1 digit of precision.
        Example: {@VIC_ADATA, idx=10, col=H}  - show the 8th column (i.e., Load, in a given setup) from the 10th image in the test.

VIC_CSV_DATA:

        Used to insert data from external csv files. Can be used either to look up spreadsheet cell entries (e.g., cell=B3) or for key-value pair 
       lookups. In the latter usage, one column in the csv file is used as the key column and should hold unique descriptors of the values 
        in the value column. For instance, the key column could have entries ‘modulus’, ‘poisson’, ‘sample_id” and the value column would 
       contain the numerical values for the elastic modulus, the poisson ration and the sample’s identification number.

       file: path to csv file on disk
       cell: spreadsheet cell (e.g., A1, C32)



       key_col: column that holds keys for key-value pair lookups
       val_col: column that holds values for key-value pair lookups
       key: string in key column
       fmt: floating point format (‘g’, ‘f’)
       prec: precision specifier (number of digits)

       Example: {@VIC_CSV_DATA, file=testinfo.csv, cell=B3}  - shows the value from cell B3 of the specified spreadsheet.
       Example: {@VIC_CSV_DATA, file=testinfo.csv, key_col=D, val_col=E, key=modulus}  - scans row D for the keyword “modulus” and 
       pulls the matching value from row E.

Calibration values:

       The following calibration values support the following options:

       cam: camera id (default: 0)
       fmt: floating point format (‘g’, ‘f’)
       prec: precision specifier (number of digits)

       VIC_CAM_CX, VIC_CAM_CY: x/y center coordinates (pixels)
       VIC_CAM_FX, VIC_CAM_FY: x/y focal length (pixels)
       VIC_CAM_S: skew factor
       VIC_CAM_K1, VIC_CAM_K2, VIC_CAM_K3: distortion coefficients
       VIC_CAM_MAG_AVG, VIC_CAM_MAG_MIN, VIC_CAM_MAG_MAX: average, minimum
       and maximum magnification (pixels/mm)
       VIC_CAM_ERROR: residual error for calibration (pixels); use cam=-1 for the rig error.

       Example: {@VIC_CAM_CX, cam=1, ‘f’, 2} - shows the center (x) for camera, floating point, 2 digits of precision.
       Example: {@VIC_CAM_ERROR} - shows the error score for camera 0 with no formatting.
       Example: {@VIC_CAM_ERROR, cam=-1} - shows the overall error score for the rig.

       The external camera calibration values support the following options:
       fmt: floating point format (‘g’, ‘f’)
       prec: precision specifier (number of digits)

       VIC_RIG_RX, VIC_RIG_RY, VIC_RIG_RZ: rotation angles (degrees)
       VIC_RIG_TX, VIC_RIG_TY, VIC_RIG_TZ: translation vector (mm)

       Example: {@VIC_RIG_RY} - shows the RY (stereo angle) for the rig.

Analysis Settings:

       VIC_STRAIN_FILTER_SIZE: size of strain filter used (pixels)
       VIC_STRAIN_TENSOR: type of tensor
       VIC_SUBSET_SIZE: subset size (pixels)
       VIC_STEP_SIZE: step size (pixels)

       Example: {@VIC_SUBSET SIZE} - show the subset size for the analysis.

Tables (VIC_TABLE_CSV):

       The template generator supports generation of tables from comma-separated variable files using the tag VIC_TABLE_CSV. This tag 
       has to be added to the name field (ODT) of an existing table. The last row of the table in the template must contain spreadsheet 
       column specifiers.

       file: path to csv file on disk
       start: integer value for start row
       end: integer value for end row, or -1 to use entire table



Plots

@VIC_PLOT_2D: Inserts a 2D plot.
       
       2D plots support the following options:
       idx: the image index (default 0)
       cam: the camera to view (default 0)
       var: the name of the variable to plot (default “W”)
       c_range: the contour range, separated by a colon

@VIC_PLOT_3D: Inserts a 3D plot.

       3D plots support the following options:
       idx: the image index (default 0)
       cam: the camera to view (default 0)
       var: the name of the variable to plot (default “W”)
       c_range: the contour range, separated by a colon
       view_angles:  the 3 viewing angles, separated by colons (default 60:0:30)

@VIC_IMG_EXTERNAL:  Inserts an arbitrary image.

       External images support the following option:
       file: the file name 

@VIC_IMG_REFERENCE: Inserts the reference speckle image.

       The reference image tag supports the following options:
       cam: the camera to view (default 0)

@VIC_IMG_SPECKLE: Inserts a speckle image.

       The speckle  image tag supports the following options:
       idx: the actual image number (not a percentage or negative number)
       cam: the camera to view (default 0)

@VIC_IMG_AOI: Inserts the reference image with the AOI overlaid.
       
       The AOI image tag supports the following options:
       subset: set “subset=true” to show the subset grid overlaid on the AOI.
       startpoints: set “starpoints=true” to show start points overlaid on the AOI.

MARKER TRACKING
To enter the marker tracking mode in Vic-3D, click the          button in the main toolbar, or select Project... Marker editor from the main 
menu. The marker tracking toolbox will appear at the top right:



To switch between different image views, you can click the                                      buttons to view the camera 1 image, camera 2 
image, or both at once in a horizontal or vertical tile. Markers may initially only be placed on the camera 1 image.

To place markers on the image, click either         or         to place an elliptical or quadrant style marker. (You can also place a 
marker on any visible feature using the         tool, but it will not be automatically tracked and must be manually placed for every 
image.) Then, click in the image (“Marker Editor 1”) to place the marker:

If a marker is found, the position of the placed marker will snap to the marker center. For best marker fitting and tracking, you can use 
the Maximum size control to select the approximate size (in pixels) of your markers; this will prevent false matches on marker edges 
or object corners.

After the marker is placed in the camera 1 image, it must be matched in the camera 2 view for stereo tracking. Start by making sure the 
relevant marker is selected (markers can be selected using the           tool).  Click the          (associate marker) tool, and click the matching 
marker in the camera 2 view.  If the Show epipolar line box is checked, a green constraining line will be displayed in the matching image 
to help identify your choice.

The marker should snap to the detected image marker:



To place more markers, continue to add markers in the “1” image and associate them in the “2” image. If desired, a marker can 
be labeled with alternate text by selecting the marker, and then entering the label in the Label field in the marker tool box.

To begin tracking markers, select         (Track all) to track all placed markers. Then, use the Animation tools to either step through 
images one at a time, or play through all images. Vic-3D will attempt to find the new marker positions in each image.

In some cases of large motion or closely placed markers, Vic-3D will be unable to track the marker and you must provide an 
initial position. When this happens, the marker will be flagged with a “?”:



To correct the position, use the          tool to drag the marker close to the center. Vic-3D will lock on to the new position and you 
can continue tracking through images.

If Vic-3D cannot find the marker automatically, it may be necessary to force a position. To do this, use the       (place manually) 
tool. This will give less accuracy than the subpixel marker matching algorithm within Vic-3D so it should be used only when the 
marker cannot be found automatically.

When many manual positions are required, it may be more convenient to turn tracking off for some or all points. To select a 
different tracking mode, click        to track no markers, or         to track only the selected marker.

Once all marker positions have been tracked, you can export the marker data.

EXPORTING MARKER DATA
To export tracked marker data, click on Data... Markers... Export marker data in the main menu bar. You will be prompted for a save 
file name, and then the Export markers dialog will appear.

THE F ILES TAB



To select a new output file, click the icon next to the Output file label.

The Files list allows selection of files to process for export. By default, locations are exported for each file, but you may select 
any number of files. Right-click in the list to modify your selection or select preset intervals.

The Reference frame control selects the image to use as the reference; all point displacements will be calculated relative to 
locations in this image.

THE MARKERS TAB

This tab lists the markers and allows you to select which ones to export data for. Select one or more, or right-click to select a range or 
interval.

THE VARIABLES TAB



Use this tab to select output variables. The available output variables are:

X, Y, Z: spatial location of each point
U, V, W: displacement of each point, relative to the chosen reference frame
Projection error: error in match location between left and right camera
x0, y0: pixel location of the marker in the camera 1 image
x1, y1: pixel location of the marker in the camera 2 image

THE COORDINATE SYSTEM TAB

By default, the coordinate system for the markers will be the existing coordinate system of the project. You can also select a 
plane fit (the best fit plane of the markers in the reference frame), or a predefined coordinate system transform from 
the existing project.

If the Plane fit option is selected, the markers used for the fit can be selected in the list at the bottom. At least three markers 
must be selected for plane fitting.



THE DISPLACEMENT REMOVAL TAB

By default, the absolute locations of each point are given. You can also remove the mean displacement (which removes the average 
U/V/W displacement, but not any rotation), or the average rigid body displacement (removes average displacement and rotation). If 
a displacement removal option is selected, use the list at the bottom to choose the markers used in the calculation; to remove 
displacement and rotation, at least three markers must be selected.

FFT ANALYSIS
Vic-3D incorporates a mode for transforming time-domain displacement and strain into the frequency domain. To begin, click 
the FFT icon () in the toolbar. If you have not already run the FFT analysis, you will be prompted to do so:

Click Yes to see the Frequency Analysis dialog.

Once the analysis is complete, you will see Vic-3D’s frequency workspace.



To start, the Maxima tab is shown.

MAXIMA PLOTS



The top left plot shows the maximum amplitude for the selected variable, and the top right plot shows, for each point, the frequency 
corresponding with this maximum amplitude. To select a different variable, you can right-click in either plot and select Variable. 
Use the mouse wheel to zoom in the plots, and click and drag to pan.

You can also view these plots in 3D. Right-click and select Show 3D plot:

The amplitude is plotted as a contour on a 3D shape plot. You can also view the amplitude value as a 3D shape; right-click and select 
Z-axis... Contour variable. This will show the maximum amplitude as a shape.



The bottom left plot shows the average amplitude vs. frequency for the selected variable; here, peaks are seen at 25 and 50Hz. 
The bottom right plot shows the average value vs. time for the selected variable.

You can view detailed amplitude/phase data - for a given frequency - by click the Amplitude/Phase tab.

AMPLITUDE/PHASE PLOTS

The top left plot shows the amplitude, for the selected variable, at the selected frequency. The top right plot shows 
the relative phase for the selected variable at the selected frequency. To change the displayed frequency, click and 
drag the small round marker at the top left of the Average Amplitude plot below:



Or, enter a value in the F= spin box in the FFT tools toolbar:

he plots will change to reflect the data for the given frequency (here, the 50Hz peak).

To change the variable, right-click in the plot and click Variable. You can view a 3D plot by right clicking and selecting Show 3D 
plot.

In a 3D plot, you can select Z-axis... Contour variable to view the amplitude at this frequency plotted as a shape. If W is displayed, 
this effectively plots the mode shape for the frequency:



PROBING INDIVIDUAL POINTS

To view the amplitude vs. frequency and phase vs. frequency plots for a given point, click the add point button (        ) in the 
FFT tools, and then click in the plot. Additional lines will appear on the graphs below:

To remove probe points, click the  button in the FFT tools, and then click on the point.
To specify the reference point (which will become the point where phase=0), click the  button, then click on the reference. The 
extract lines in the phase plot at the lower right will re-reference to this point.

EXPORTING DATA

To export extracted or average amplitude and phase data, click the Export FFT Data button in the FFT Tools.

Select the desired points and variables; you can export amplitude, phase, or both for each point as well as for the average of the data. 
Click OK to select a filename and create a CSV file.



THE FREQUENCY ANALYSIS DIALOG
To calculate FFT frequency domain data for your dataset, click Data... Postprocessing tools... Frequency analysis. The Frequency 
Analysis dialog will appear.

The available data set is displayed on the right (here, the specimen was a loudspeaker cone). The default FFT analysis window is displayed 
as a box; you can redefine this area by clicking and dragging within the data plot. Use the mouse wheel to zoom; hold the Shift key to 
pan.

Overlaid on the data is a grid of analysis points. Each of the green points will be analyzed and converted to the frequency domain for 
later plotting; red points indicate areas where no data is present. The sample step can be adjusted with the Sampling step spin box; 
smaller sample steps will require more memory and slightly more analysis time.

For the frequency to be calculated correctly, enter the correct image time step in the Time step spin box; or, to enter the frequency, 
pull down to Frequency [Hz].

Data to be used for frequency analysis often involves very small displacements which may be difficult to resolve; because of this, a 
smoothing filter can be applied during the FFT analysis. Select the radius for the filter using the Smoothing filter spin box, or set this 
value to 1 to apply no smoothing.

To save the data for future sessions, check the Save FFT Data box and, if desired, select a new filename. If this box is cleared, you will 
need to re-run the analysis to see the data again.

If desired, select additional or fewer variables for extraction. Selecting more variables will use more memory.

The data files to be included are listed in the Data files group box and you can choose to remove certain data files if desired.



When the settings are correct, click the Start button. The data will be processed (this can be quite time consuming for large data sets), 
and then you will be taken to the frequency workspace. 

REAL-T IME ANALYSIS
To enter real-time mode, first start start Vic-Snap and start the real-time server (see Vic-Snap documentation for details). Then, start 
Vic-3D and select File... Mode... Real-time 3D Analysis.

You will be prompted for a server address and port:

With Vic-Snap running on the local PC, select localhost; if Vic-Snap is running remotely, you may enter the IP address of the acquisition 
PC. The Port setting should be left at the default unless there is conflict. 

Vic-3D will attempt to connect to the image server; when the connection is established, a live view will appear in the workspace, and 
the real-time tools will be displayed:

CALIBRATION IN REAL-TIME MODE

Calibration must be performed outside of real-time mode. There are two possible routes:

        • Calibrate in Vic-Snap. If a calibration is present in Vic-Snap when you start real-time mode, it will be transferred to Vic-3D, and 
            will appear in the Calibration tab. Or, click Calibration in the tool set to transfer at a later point.
        • Calibrate in Vic-3D. Before beginning the test, complete a standard calibration in Vic-3d, and save a project file. After entering 
            real-time mode, select Calibration... Import calibration, and select the previously saved project.

SELECTING A REFERENCE IMAGE

To select a reference, click Reference in the real-time tool set. The currently displayed live image will be copied and used as reference. 
You may draw AOI’s on this image exactly as in the standard Vic-3D mode.



RUNNING THE ANALYSIS 

To being the real-time analysis, click the green Start Analysis button in the toolbar, or select Data... Start analysis. Incoming 
images will be analyzed and transferred in sequence as fast as the processor and transfer speed allow.

ANALYSIS OPTIONS

Correlation options may be adjusted before or during the analysis. If the analysis is already in process, the changes will not take 
place until you restart the correlation.

PAUSING THE ANALYSIS

In order to make changes to coordinates and contour levels, it may be helpful to pause the analysis by clicking Pause. The button 
text will change to Resume; click to resume.

NOTES

        • The data analyzed in real-time mode is displayed but not saved. To allow later processing and storage of data, be sure to 
           store the images in Vic-Snap as usual (timed capture, manual capture, etc.)
        • To obtain the best frame rates in Real-time mode, select a large step size; this will result in fewer points being analyzed 
           and more total updates per second.
        • Select a desktop PC with 2, 4, or 8 cores for maximum analysis speeds. With a fast PC and a larger step size, frame rates 
           of 5-10 per second can be realized.
        • Real-time mode is available with an optional module.

CAL IBRATION DISTORTIONS
To calibrate a stereo-microscope, start by selecting Stereo-microscope mode in Vic-3D (File... Mode... Stereo-microscope). The following 
dialog appears. 



ADDING TRANSLATION IMAGES

Add translation image pairs by clicking Add images. Select the desired images and click Open.

Select a Subset size that is appropriate to the speckle image. For most situations, the Step and Coefficients settings can be left 
as is. Click Run to begin the analysis.



When analysis is complete, a message indicating success or failure will appear. Click to continue, and save the project to store 
the distortion correction map.

STEREO CALIBRATION

Once the distortion correction is complete, you can add stereo grid images and calibrate as usual. The distortion order is not 
selectable as the distortion is corrected by the inverse mapping function.

For the Camera pulldown, you must select whether the magnification of the system was greater than or less than 1:1. Selecting the 
wrong option will result in an inverted Z-axis.

ANALYZING SPECKLE IMAGES

Once the distortion and grid calibration is complete, you can add and analyze speckle images as usual. The data will be processed using 
the distortion map and corrected.



BATCH PROCESSING MODE
Vic-3D has a batch processing mode for running one or more project files without user intervention. To use this mode, start 
Vic-3D from the command line with the following arguments:

Vic-3D -R filename1 [filename2] [...]

This will create or append to a log in the c:\users\yourname folder called Vic3D_batch_log.txt. To redirect the log file to a path 
and name of your choosing, use

Vic-3D -R filenames -L logname

In this mode you will see a tray icon for Vic-3D that will show progress and allow cancelling. Right click on the tray icon to cancel 
or view the current progress.

The log file will contain information on project start and stop times, points processed, projection error, and any associated 
warnings or errors.

QUICK START
There are only a few steps involved in obtaining shape and deformation measurements from your images. If you are using Vic-3D for 
the first time, take a look at the example provided with the program. Then, try to go through the following steps yourself to quickly 
familiarize yourself with the program usage:

   1.         Add your calibration images to the project.
   2.         Perform the calibration.
   3.         Add a reference image and select your area of interest.
   4.         Add more speckle images, if applicable.
   5.         Run the correlation analysis.
 6. Plot the results

If you encounter any difficulties, please do not hesitate to contact our technical support department.

WHAT’S NEW IN VIC-3D 8
        • Automated report and presentation generation from templates
              Insert data, charts, and graphs automatically
        • Create a new project based on a template
               Use existing calibrations, AOIs, and settings
              Streamline repeated tests
        • Improved support for Windows 10 and high-DPI displays
        • Improved AOI editing features
        • Improved extraction features
        • Automatic IR mapping when used with Vic-Snap
        • Python module provides postprocessing opportunities limited only by your imagination and Python skills

TRANSIT IONING FROM EARLIER VERSIONS
        • In the Calibration dialog, instead of selecting High magnification or Distortion order directly, specify or create the appropriate 
            Imaging system.
        • If you have a complex calibration in your project, you will not be able to open it in earlier versions of Vic-3D.



TECHNICAL SUPPORT
If you cannot find an answer to your question in this manual, please do not hesitate to contact our technical support at 
support@correlatedsolutions.com. You can also find contact information at our web site at www.correlatedsolutions.com.

We will be happy to assist with topics such as:

        • Designing digital image correlation experiments
        • Calibration
        • Troubleshooting errors
        • Interpreting test data
        • Achieving optimal results

BUG REPORTS AND FEATURE REQUESTS

If you encounter a bug in Vic-3D, please let us know about it. Send a short description of the problem to support@correlatedsolutions.com, 
along with any project or image files you think may help us reproduce the bug.

Also, if you think Vic-3D can be improved by adding a particular feature you would find helpful, let us know about it. We will try 
to incorporate your requests in our future updates of the software.






